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This paper will briefly discuss the development of the YarnCAD ( 3D yarn and knitted fabric 
simulation) system. The different approach taken by this group can be summed up quite simply. 
When a fabric is to be designed and then produced it is first necessary to choose a 
suitable yarn with the required aesthetic and mechanical properties. It is therefore 
logical that if an accurate computer simulation of a fabric is to be produced, we should 
begin with the accurate simulation of the component yarn. As with all simple statements of 
concept, the implications of this statement are far reaching. Only by getting CAD for yarn 
simulation right will CAD for Fabric simulation be accurate. From the earliest stages of 
development, one of the demands from design and manufacturing companies was for yarn 
simulations to be included. However, as most of the systems had been developed using 2D 
fabric simulations then the only option was to superimpose scanned in or painted 2D yarn 
images on top of the simulated fabric structure. 
This study examined the relationship between the textile designer and technologist and how the 
design of the YarnCAD system has to accommodateThe possible areas of 
misunderstanding/misinterpretation. 
An experiment was designed requiring individuals to use the system to design their own yarn 
and then to try to simulate a given real yarn. The methodology used to capture and analyse the 
data obtained is known as ‘Protocol Dialogue Analysis’ or ‘Think Aloud Method’. This simply 
means that the subject is asked to articulate their thoughts as they carry out the task. Twelve 
participants took part in this exercise, each having a design or textile technology background 
and education. This results in many pages of statements which have to be refined and coded in 
order to discover trends in problems, misunderstandings, misinformation, poor navigation etc in 
the system. 
Introduction 
The  aim  of  this  project  was  to  support  collaboration  between  textile  designers  and 
textile  technologists,  by  identifying  the  communication problem  between  them,  then 
providing solutions and support systems to be used in different ways by individual users 
even those who have different levels of textile knowledge, so that both textile designers 
and textile technologists can make use of CAD systems in an appropriate way to tackle 
systemic problems of the design process by giving different contributors access to the 
information and expertise of their colleagues. 
The support CAD system allows designers to develop comprehensive and compatible 
specifications  which  are  consistent  with  their  design  ideas.  The  communication 
problems could be resolved by reliable specifications of the support system, such as 
database of information on fibre and fabric properties, as well as any available expertise 
and  historical  data.  This  can  have  wider  consequences  for  the  design  process,  as 
designers and technicians respect each others expertise, they might also respect each 
other’s opinion in other issues and treat each other with higher regard. 
A number of  valuable  papers have  been written  (Eckert,  C.  et  al    1994,1998,2004) 
about  the  knitwear  design  process,  the  communication  problems  between 
technologists and designers and the use of a CAD support system to obviate these. 
However,  these  papers  did  not  attempt  to  identify  the  parameters  involved  at  the 
technology  gap  or  to  suggest  possible  CAD  interface  solutions  to  ameliorate  these 
problems. This paper will attempt to do so though it must be realised that this is a précis 
of a detailed study (Hsieh, W­H. 2007). The yarnCAD software package was used as



the  vehicle  upon  which  the  study  of  the  designer/technologist  interface  could  be 
undertaken and this tool will now be briefly introduced. 
The YarnCAD System 
The YarnCAD system is a computer tool that helps in narrowing the gap between the 
textile  designer  and  technologist  in  their  joint  work  on  producing  new  yarn.  The 
designer expresses his ideas about new yarn in a form of visual image whereas the 
technologist thinks in terms of technical specification of yarns and fabrics. The existing 
approach  to  developing  new  products  involves  a  repetitive  and  time  consuming 
process of yarn and fabric sampling until the required resemblance between the initial 
image and produced yarn is found. The main advantage of the YarnCAD system is that 
idea realisation and yarn parameters assessment can be brought forward within the 
design process without  the need for expensive yarn production. This  is achieved by 
generating realistic 3D images of yarn and fabric, designed from the initial technical 
specification of spinning process, yarn and fabric. 

YarnCAD system consists of four major components: 
• The user interface 
• The mathematical models used for simulating different types of yarns and knitted 
fabrics 
• The graphic engine for yarn/fabric visualisation 
• The yarn data base 

The user  interface  is based upon a standard Windows Multiple Document  Interface 
(MDI) where each document window presents a 3D graphical  image of  the yarn or 
fabric. The interface gives the user maximum flexibility in manipulating the yarn and 
fabric parameters and any change immediately affects the image. 
Parameters  defining  the  yarn  are  entered  via  a  sequence  of  dialogues.  The  user 
selects  the  type  of  yarn  (e.g.  knitting,  weaving),  the  manufacturing  process  (e.g. 
woollen, worsted), the yarn effects (e.g. plain, slub), and the type of knitted fabric (plain 
single jersey or 1+1 rib). Strands are added or removed as desired from the list. The 
set of parameters that are individually editable for each strand includes colour, count, 
twist level and direction, fibre type, coefficient and spectrum of unevenness, and some 
others specific for different types of yarn. The sample of knitted fabric is defined by its 
size and stitch density in horizontal and vertical directions. The full specification of yarn 
and fabric can be printed out  together with  its  image, or stored via a standard filing 
system. 
Designing a New Yarn 
*  To start designing a new yarn or fabric choose File→New item in the Main Menu or 
click New  icon in the Tool Bar and then input the necessary data using the dialogue 
boxes. The system enables single, 2­, 3­, and 4­ply straight yarns and slub yarn to be 
simulated. 

The design process starts from Yarn Production dialogue (Figure1.) where the yarn 
type can be chosen from  the options Knitting, Weaving, Crepe, Braided Knitting, 
and Braided Weaving, and the spinning process can be set toWoollen,Worsted, or 
Cotton from the Process list.



Figure 1. Yarn Production Dialogue 

Click Next which brings the Yarn Effects dialogue (Figure2.). Options define yarn 
type and visual effects on the yarn surface. From the Special Effect list four choices 
are available: Straight yarn, Plain Loop and Fabric, Rib Loop and Fabric, and Slub 
yarn. It is advisable to start from the straight or slub yarn and then to put it into the 
knitted fabric sample. 

Yarn surface can be presented in four different appearances using the set of four 
buttons: Smooth,Medium, Ribbed, and Auto. The last one enables the yarn surface 
to be presented differently depending on the image magnification. 

When parameters in this dialogue are set, click Next to proceed with the designing 
process. It is possible to return to the previous dialogue by clicking Back.



Figure 2.Yarn Effects Dialogue 

If the Straight Yarn option was chosen at  the Yarn Effects dialogue, the Strands 
dialogue (Figure2.) appears on the Main Window. 
The dialogue box consists of two parts. The upper part labelled Yarn determines 
twist level and direction for the plied yarn, whereas the lower part labelled Strands 
determines properties of each individual strand. 

By default, the dialogue starts with two strands. Strands can be removed or added 
by clicking Cut Strand or Add Strand buttons. It is possible to remove any particular 
strand  by  firstly  clicking  on  the  strand  number.  Maximum  available  number  of 
strands in the yarn is four.



Figure 3. Strands Dialogue 

For each strand the following parameters should be set: colour, linear density in tex, 
twist level in twists per meter, and twist direction (S or Z). For the more experienced 
designer  it  is  recommended  to  use  More  button  which  brings  More  Strand 
Properties dialogue. 

Strand colour can be set by clicking the coloured area next to the strand number. This 
initiates the Colour dialogue where the colour of the strand can be chosen from the 
palette of 48 pre­designed colours or from 16.7 million colours by clicking Define 
Custom Colours button. 

Yarn  linear density and twist  level can be determined either from the list of pre­set 
values or by entering appropriate number into the box (Figure 3.). 
Yarn twist direction can be set to Z or S direction using Twist Direction button. 

When all individual yarn strands are determined, it is necessary to set twist level 
and direction  for  the plied  yarn using upper part  of  Strands dialogue  (Figure 3.) 
which is similar in its functionality to the lower part. 

Advanced option of Strands dialogue (Figure 3.) determines specific parameters 
of the two­ply yarn production described in Appendix. 

Click Finish button and the 3D image of the yarn with the specified properties will 
be presented in the window labelled YarnPa1 (Figure 4.). If instead the Back button 
was clicked then the Yarn Effects dialogue would be presented.



Figure 4. Example of the two­ply Yarn Image 

All yarn parameters can be modified using Yarns→Specification in the Main Menu 
or by clicking Specification icon. 

Colour of any individual strand can be changed using View→Custom Palette in the 
Main Menu or by clicking Toggle Palette icon. 

Yarn image can be viewed from different angles by rotating and moving the image 
in 3D. 

It  is  possible  to  design  many  yarns  and  fabrics  with  different  combinations  of 
properties.  Each  new  yarn  will  be  shown  in  an  individual  window  consecutively 
labelled YarnPa2, YarnPa3, and so on. It is possible to see all the designed yarns 
by using Window→Tile (Figure 5.)



Figure 5 Example of Tiled Windows 

Procedure for User Testing 
The experiment was carried out in 12 individual sessions, which were all held in the 
same usability lab. During each session, video recordings were made of the computer 
screen and the participant’s voice, while the experimenter was also present to observe 
and take notes. 
The planning and design of the user testing was based on the framework laid out by 
Rubin (1994)  in his book, “Handbook of Usability Testing: How to Plan, design, and 
Conduct  Cost  Effective  Tests.”  The  conducted  user  testing  consisted  of  a  main 
performance  test  designed  to  gather  extensive  usability  data  via  verbal  protocol 
analysis and a post­test questionnaire. The main performance test was composed of 
the following four steps: 

(1) Participant greeting and a background questionnaire. 
Upon  arriving,  each  participant  was  greeted  and  asked  to  fill  in  the  first 

questionnaire  on  demographic  details,  such  as  age,  gender,  work  experience, 
specialism and education. It also enquired of the participants’ experience in working 
with software systems. Participants were also advised that they would be anonymous 
throughout the session, and that they were given nondisclosure statements. 

(2) Orientation 
After  completing  first  questionnaire,  the participants  received a  short,  verbal 

introduction and orientation to the test, explaining the purpose and objective of the test. 
These  instructions, which were  read out from paper to ensure consistency,  told  the 
participant  to:  ‘think  aloud  while  performing  your  tasks,  and  pretend  as  if  the 
experimenter was not there. Do not turn to her/him for assistance. If you fall silent for a 
while, the experimenter will remind you to keep thinking aloud. Finally, remember that 
it is the software, and not you, who is being tested’. All parts of the test were explained



and  the  participants  were  notified  of  their  right  to  leave  the  session  should  they 
become uncomfortable. 

(3) Performance test 
The  performance  test  consists  of  three  major  tasks  including  software 

exploration, user manual, and knowledge of textiles. For each task, user verbalizations 
and keystrokes were  recorded, using video  tapes which  included the audio  records 
and screen capture routines using Camtasia Studio™ recorder. At the end of the tasks, 
a full transcript of each session was made, matching verbalization with keystrokes and 
screens. 

(4) Participant debriefing 
After  all  the  tasks were  completed or  the  time expired,  each participant was 

debriefed by  the experimenter  in one of  the  side  rooms and  the debriefing  session 
audiotaped. The debrief included the following: 

•  Filling  out  a  brief  preference  questionnaire  pertaining  to  subjective 
perceptions of usability of YarnCAD 
• Participant’s overall comments about his or her performance 
• Participant’s  responses to probes from  the  test monitor about specific 
errors or problems during the test 

The debriefing session served several functions. It allowed the participants to 
say whatever they like, which is important if tasks are frustrating. It provided important 
information  about  each  participant’s  rationale  for  performing  specific  action,  and  it 
allowed  the collection of subjective preference data about  the software through  the 
post­test questionnaire. 

Number of Participants Required 
Nielson  (1994)  suggests  that  sample  sizes  as  small  as  five  participants  will  yield 
sufficient information about problem solving behaviour. Nielson (2000) further points 
out that “as soon as you collect data from a single test user, your insights shoot up and 
you have already learned almost a third of all there is to know about the usability of the 
design. When you test the second user, you will discover that this person does some of 
the same things as the first user, so there is some overlap in what you learn. So the 
second user adds some amount of new insight, but not nearly as much as the first user 
did. As you add more and more users, you learn less and less because you will keep 
seeing the same things again and again.” 
So Nielson states that “after the fifth user, you are wasting your time by observing the 
same findings repeatedly but not learning much new.” 

Test Environment and Equipment Requirements 
The lab for the user testing was a simple setup (Figure 5.), including one seat, a laptop 
with the YarnCAD system installed and the Camtasia Studio™ recorder, which could 
clearly  record participant  on­screen activity  and verbal  data at  the  same  time. One 
video camera was used to take down the graphics on screen and audio data as well as 
to prevent any unexpected technical problems occurring during the testing by losing 
data. Both verbal data and the mouse movements and click actions on the screen can 
be used as the basis for coding and verbal protocol analysis. 
The main role of the researcher was simply as an observer during the entire testing. 
The researcher operated the camera, worked silently and stood behind in order not to 
interfere with the test.



Figure 5. User Testing Lab with Video Recording 

User Profile 
The main concern of  this research was how to narrow the gap between design and 
technology.  To  ensure  valid  information  during  our  think  aloud  study,  the  authors 
decided  to  use  12  participants.  This  number  far  exceeds  the  overall  sample  size 
deemed necessary by Nielson (1994), sufficient information should be available even 
after discarding. 
The research was conducted with a sample of 12 participants, all of whom were staffs 
or students from School of Design at the University of Leeds. At the time of the study, 
each of them had a textile education background and/or work experience in the textile 
industry,  which  generally meant  that  they had some basic  textile  knowledge.  They 
included a variety of specialists from yarn, weaving, knitting and printing. 

To collect participants’ protocols and data, the author used the Camtasia Studio™ recorder 
(TechSmith  Corporation)  for  all  video  captures  of  on­screen  activity  including  a  timed 
recording  of  all  the  mouse  movements  and  click  actions  and  to  record  a  simultaneous 
think­aloud protocol without  disturbing  the  testing process. Subsequently using a coding 
scheme, every word  is transcripted as well as all  interjections and exclamations,  in 
order to reconstruct on paper what has been said during the session. 
Teaching Participants How to Think Aloud 
During the testing, although some participants can spontaneously respond aloud without any 
difficulty, it is most likely that they normally do their work silently. However, participants who 
felt that “thinking aloud” seemed unnatural were not prompted, following Green (1998). 
As part of the instructions to participants during the pretest briefing, the experimenter 
let the participants know that he was interested in what they were thinking about when 
performing the task because he valued their reactions to the product. He asked them 
to  think aloud as  they worked, not  just  a description of  the  task  itself  because  the 
experimenter prefers  to any  suggestions or  explanations of  the  software,  these will 
help experimenter to improve afterwards. 
TASKS SET FOR PARTICIPANTS 

In order to evaluate the YarnCAD system by means of  think­aloud protocols, 
three major tasks were formulated that together cover the software exploration, user 
manual, and knowledge of textiles. All tasks were designed to be equally difficult, and 
could be carried out independently from one another, in order to prevent participants 
getting stuck after one or two tasks. The entire set of tasks was as follows: 

Study 1: Simple searching task



Task 1 was designed to generally evaluate the function keys of the software including 
the main menu  and  tool bar,  which allow participants  to  design a  new  yarn,  try  to 
explore for themselves without reading the YarnCAD user manual. 

Study 2: Information (manual) provided task 
Task  2  focuses  on  the  user  manual,  the  participants  had  to  read  and  find  the 
information  provided  on  designing  a  new  yarn  of  their  choice  while  producing  a 
think­aloud protocol. 

Study 3: Simulation yarn task 
Task  3  was  designed  to  test  the  knowledge  and  process  of  yarn  production.  The 
participants  had  to  simulate a  yarn provided  for  them,  focus on  understanding  the 
process of design from real yarn. 

Coding Procedure and System 

Once the 12 sessions were completed, the participants’ explorations and other 
mouse click actions were studied in order to detect usability problems in the YarnCAD 
system.  As  a  result,  the  best  five  original  verbal  protocol  data  were  selected  and 
segmented in clauses and coded by the author. The verbal protocols were coded with 
the program MAXQDA. Altogether, the corpus consisted of 1558 coded segments in 
total. To increase the reliability of analysis, the author applied a method similar to the 
Delphi Method, each protocol was encoded twice. There was at least a ten day break 
between the first coding exercise and the second coding exercise. Subsequently, the 
final protocols were encoded  through arbitration of  the  first coding and  the  second 
coding. 
Each utterance was coded using the following variables. 
Type of Action 

The  author  distinguished  two  generic  types  of  actions:  active  and  reactive 
actions. These related to different levels of verbal data in Ericsson and Simon’s model. 

1. Active actions are verbalization of tasks resulting from deliberate user goals and 
intentions (I am going to the homepage). These utterances of active actions also refer 
to level 1 and level 2 data according to Ericsson and Simon’s theory. 

2. Reactive utterances start  from an observation  in  the  task context  (mainly on  the 
computer screen) which asks for a reaction from the user (I cannot click on this item) or 
an evaluation (This is not what I am looking for). These reactive utterances represent 
level 3 verbalizations provide usability practitioners with data  required  to build up a 
friendly and ease­of­use product. 

3.  Interjections  and  exclamations  are  regarded  as  non­code  utterances  in  the 
transcript of what had been said during the session. 

(adapted from Hooijdonk, C V and Maes, A and Ummelen, N, 2005) 

Table 1  shows  a  fragment  of  the  coding  history  for  one  participants. Some of  the 
participants’ contributions had to be discarded as they had not been able to carry out 
the think aloud exercise effectively. Eventually seven usable records were identified 
and the best five of  these were used in the analysis. From these it was possible to 
identify  the  main  problems  experienced,  to  different  degrees,  by  designers  and 
technologists with regard to parameter requirements and pre­knowledge. It was also



possible to identify the main usability issues and consequent interface solutions. 

Table 1. A Fragment of Coding History 
(A: Active Action; R: Reactive Action; N: Non­code; 
PL: Layout Problem; PT: Terminology Problem; PD: Data entry Problem; PC: 

Comprehension Problems; PS: Slow Response) 

NO  1 st 

code 
2 nd 

code 
Arbitrated  Dialogue  time  Action 

52  PD  PD  PD  I  don’t  see 
anything 
different 
when  you 
click on yarn 
dialogues… 

8.04  Click 
smooth/medium/ribbed/auto 

53  N  N  N  Oh…  8.15 
54  A  R  R  I’m  going  to 

do  this 
again… 

8.18  Click 
back/weaving/worsted/next 

55  A  R  R  I’m  going  to 
do  this 
again… 

8.26  Click slub/next 

56  N  N  N  oh…  8.31 
57  PD  PD  PD  but I can’t go 

backwards… 
8.36 

58  A  R  R  I  wanted  to 
add  more 
strands. 

8.40  Click cancel 

59  A  A  A  I’m  going  to 
start  this 
again. 

8.46  Click 
file/new/weaving/worsted/next 

60  A  A  A  And… 
choose 
straight… 

8.56  Click straight/next 

61  N  N  N  okay…  9.00 
62  R  R  R  so  here  you 

can  add 
strands. 

9.02  Click add strand 

63  R  R  R  What  is  the 
number  of 
yarns  is  4? 
Okay 

9.07  Add yarn to 4 

64  N  N  N  So…  9.12 
65  A  A  A  I’m  going  to 

change  the 
colours… 

9.19  Click colour (strand 3) 

66  N  N  N  mmmm…  9.25 
67  N  N  N  And…  9.29  Click colour (strand 4)



Conclusions 

Technology Gaps 

The  authors  employed  the  YarnCAD  system  as  a  measurement  tool  to 
investigate  the gap between designers and  technologists, and  the  result was quite 
surprising  as  it  revealed  a  lack  of  basic  textile  knowledge  in  both  designers  and 
technologists. It is reasonable to assume that such a problem will have a major impact 
on  the  knitwear design process.  It  certainly  supports  the  statement  from Kavanagh 
( 2004), which is 

‘When  it  comes  to acquiring  technical knowledge a designer’s ability  to exploit  that 
knowledge will often be dependent on how well the designer is able to communicate 
with technologists. 

These main issues will be discussed here as bullet points but we will stick to the 
yarn design matters and ignore the more general navigation matters which were also a 
part of the study. 

(1) The first input parameter which caused problems to the participants was that 
of which type of yarn did  they wish  to create. They were given  the choice of 
‘woollen/condenser spun; worsted/roller drafted; and cotton spun’. Of the twelve 
participants  only  one  was  confident  in  answering  this.  Rather  disappointing 
when we consider the backgrounds of the subjects but it made us realise that 
some form of  image would have to be provided to ensure that user would be 
able to make a correct choice. 

(2) The next input parameter which caused problems was ‘linear density’. It had 
been  decide  that  the  interface  would  use  ‘tex’  as  the  most  common  count 
system. However not only did we find that more of  the participants preferred 
‘Metric’ or Worsted’ we also found that the understanding of the count systems 
was generally poor and that knitters were much more comfortable when given a 
choice of a count range which would suit a particular gauge of knitting machine. 

(3) If  linear density had proven surprisingly difficult  then twist was even more 
challenging  for  the  subjects.  Only  one  had  any  idea  about  the  relationship 
between  linear density and  twist content at  the single strand  level and, more 
surprising, was that very few had any understanding of the use of different twist 
direction.  It has  therefore been decided  that  interface will offer  the  choice of 
‘hard twist, normal warp, normal weft, hosiery and soft hosiery’. 

(4) Another surprisingly difficult decision amongst the subjects studied was that 
of the folding twist. It has been decided to simply offer the choice of a hosiery 
twist which is 0.5 X single twist or a balanced twist which is 0.67 X single twist. 
Of  course  the  user will  be  able  to  alter  the  default  values  for  customisation 
purposes and for yarns comprising more than two strands. 

(5) The original interface system also offered packing factor as an input variable



however this is not a commonly used term in the industry and so descriptions 
such as lean, bulky and very bulky will be offered. 

(6) The original interface also offered CV of irregularity as an input and this will 
still be offered although it has been found that few users really understood what 
this was. It should be the CV figure obtained from a standard evenness tester 
such as the Zellwegger Uster Tester. An average default figure could be used 
as a default value but this could be altered to allow the effect of unevenness to 
be observed. 

(7) The input parameter used in the original interface to identify the fibre type 
was the specific volume of a fibre (g/cm3). However this was an unknown to all 
the subjects and so the future  interface will offer a choice of common natural 
and synthetic fibres and default to the relevant specificl volume value. 

Solutions 

The author  re­designed YarnCAD user  interfaces  to provide solutions for the 
technological  gaps  that  had  been  found  and  for  some  of  the  main  navigational 
problems. Interface modifications were as follows: 
Interface 1: Provide a welcome screen and getting started tutorial 

(a) add a dialogue for a new yarn/open existing file. 
(b) show a getting started with YarnCAD and tutorial to beginner. 
(c) make the Help menu active. 

Interface 2: delete inactive function key 
(a) yarn type and visual properties－delete hairiness (confused user). 
(b) yarn production—type: delete item of crepe, braided knitting, braided weaving 
as these function keys are not active yet 

Interface 3: modify existing function key 
(a) add yarn material selection 

(b) show example of yarn count / knitting machine gauge. 
(c) show a picture of twist direction. 
(d) yarn production—spin process: pop up the picture of woollen, worsted. 
(e) The three main modification function keys should be bigger: show fabric; yarn 
specification; undo 
(f) set default of background colour change into grey colour rather than black. 
(g) use the simple term “bulk” instead of “average packing density”. 
(h) under the parameter more button set default of Fibre type to the Fibre density 
link. 
(i) set default when you click on selection of twist level, it will link to yarn material 
and yarn Tex system. 

These  interface changes were presented to the software design team and these were 
all incorporated into the new YarnCAD software currently being developed. 

The Use of Think Aloud for Usability Testing



Think  aloud  protocols  traditionally  have  been  used  by  academic  researchers  as  a 
qualitative  data  collection method.  This method  is  currently  gaining  acceptance  in 
industry usability testing. The authors have adopted the thinking­aloud protocol as a 
primary method for obtaining data from users. 

Nielsen’s “Usability Engineering” is the most comprehensive and practical discussing 
of usability engineering and testing, covering the usability engineering life cycle from 
product  conceptualization  to design  and  evaluation. Nielsen  states  that  think­aloud 
protocol “may be the single most valuable usability engineering method. One gets a 
very direct understanding of what parts of  the  interface/user dialog cause  the most 
problems, because the think aloud shows how user interpret each individual interface 
item”. 

Thinking aloud is recognised as a very popular and effective method in terms of 
usability testing. The advantages of protocol analysis versus other methods have been 
reported in the literature. For example, Yamagishi and Azuma (1987), Henderson et al. 
(1995)  examined  four  usability  evaluation  methods:  logged  data  of  objective 
performance,  questionnaires,  interviews  and  verbal  protocol  analyses  to  evaluate 
different software packages (spreadsheet, word processor and database) and found 
that protocol analysis is the most efficient regarding its usefulness to highlight specific 
usability problems. 

Yamagishi  and  Azuma  (1987)  concluded  that:  “Both  the  strengths  and 
weaknesses of each  technique were  isolated. Protocol analysis and  interviews are 
time consuming, but useful  in  identifying problem areas for a system. Questionnaire 
and logged data analysis, both of which can produce some sorts of quantitative results 
rather easily, are useful only for  limited purposes, such as for comparative analysis 
among systems, versions or categories of users”. 
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